The Development of Student Care Office

Assessment Procedures

Matthew Stephen Swain

A Senior Thesis submitted in partial fulfillment
of the requirements for graduation
in the Honors Program
Liberty University
Spring 2010
Acceptance of Senior Honors Thesis

This Senior Honors Thesis is accepted in partial fulfillment of the requirements for graduation from the Honors Program of Liberty University.

______________________________
Nancy Anderson, Ph.D.
Thesis Chair

______________________________
Fred Volk, Ph.D.
Committee Member

______________________________
Karen Swallow Prior, Ph.D.
Committee Member

______________________________
Marilyn Gadomski, Ph.D.
Assistant Honors Director

______________________________
Date
Acknowledgments

I would like to express great appreciation to Elisabeth Spratto, Jennifer Healey, and Kristin Sones for their research assistance. To John Collins and Brendan Horner, for their brilliant expertise and guidance in the technical portion of the project and Lisa Harre for enduring the programming phase. Thank you to Dr. Nancy Anderson, Dr. Karen Swallow Prior, and Dr. Marilyn Gadomski for writing assistance and to Dr. Fred Volk for his guidance in my professional development and in life.
Abstract

Most universities offer counseling services for their residential students. To answer accrediting bodies, such non-academic departments are now asked to assess the effectiveness of their services. Often, this requires skill sets and time that counseling centers do not possess. A collaborative effort was established with a student services office at a private university in the Southeast and the undergraduate Psychology Department to assist them in the development of new assessment procedures. An intake procedure was created to fulfill this goal. The assembly of appropriate psychometric tests as well as the designing of a computer administered version of the intake process is detailed. To assess students further, check-in kiosks were also designed. Research possibilities and suggestions for future developments are also discussed.
The Development of Student Care Office Assessment Procedures

A counseling service in higher education is a healthy resource for students who need therapy concerning a variety of issues. Mental health services are offered by most higher education institutions whether the university has a large or small student population (Vespia, 2007). Counseling services are offered since some university students face psychological distress during their educational years, and a focus on early detection is crucial (Marini et al., 2004).

A student’s willingness to seek counseling is generally based on the student’s distress level, view of counseling, personal self-concealment, and weak social resources (Leech, 2007). Cramer (1999) has outlined a model of an individual’s willingness to seek counseling. When a student has a high level of distress and generally perceives counseling as a positive endeavor, he or she will begin to look for counseling resources. Students who have a high level of distress are also more likely to self-conceal and have weak social resources. Considering this model, administrators should recognize that most students seek counseling during a time of high distress and this can occasionally interfere with data collection. A proposed means of collecting accurate client data is through an intake process; however, the intake process must be designed carefully to meet the needs of the students as well as the university office.

University Departments

The Student Care Office

Lay counseling. The Student Care Office (SCO) is a paraprofessional counseling service offered by a liberal arts Christian university in the southeastern United States. The office is located on the campus and is divided into two separate suites—one office for
male students and one for female students. Each suite is staffed with counselors and
student workers of the same gender. This facilitates a more comfortable atmosphere for
students who may present with gender-specific issues. Presently, no staff member is
licensed by the state to practice professionally, so lay counseling is the focus of the
office. A few staff members are completing Licensed Professional Counselor certification
hours while working in the department. Staff members have degrees in ministry, pastoral
care, human services, biblical studies and professional counseling.

**Office services.** The SCO formed in July 2007 as a response to the need arising
on campus for a counseling service. Prior to that time, the office was a part of both the
Dean of Men and the Dean of Women offices. The Dean offices operated as both
counseling services and conduct offices that would carry out disciplinary action. After the
realization of the need for a more targeted approach to conduct and counseling on
campus, the Student Care Office and the Office of Student Conduct formed subsequent to
the dissolution of the two Dean offices.

Four therapy services offered by the SCO include individual lay counseling, life
skills, mentoring, and crisis intervention. Individual or group therapy sessions are offered
to students within the lay counseling, life skills and mentoring categories. Special
awareness programs are sponsored and run by the department throughout the academic
year. These programs often emphasize various mental health issues and difficulties that
students encounter, such as eating disorders or suicidal ideation. The function of the
office is two-fold: lay counseling and programs advocating healthy life skills.

The SCO utilized the university system of Incident Reports to document a
student’s use of the services at the office. Incident Reports are also used by other offices
and officials on campus to record student information from residential rule infractions to a death in the family. This system was adopted by the SCO to facilitate communication between other offices on campus; however, the office lacked a procedure to record visits and psychometric data from students in a central area.

Since the genesis of the SCO, office protocol established that student appointments were based on the student’s gender, presenting problem, and availability of staff. A form issued by front desk workers collected each student’s information and was manually entered into a database each week. After a student scheduled an appointment with a front desk staff member, the student would sometimes see a counselor immediately or return at another time. Priority was given to crisis situations. During counseling, mental health issues were primarily addressed with a focus on the student’s spiritual state.

**Need for assessment.** During the fall of 2008, the staff at the Student Care Office began to seek additional resources within the university to assist in establishing an improved data collection and data management system. This assessment effort was, in part, a result of an awareness of potential evaluation by accreditation boards. Data needed to be accessible at the prospect of external and internal assessment. The staff also sought to use a more sophisticated procedure for students who sought services while anticipating a more comprehensive view of the mental health of a student. It was suggested that the SCO develop and implement an intake procedure since most counseling institutions use an entrance assessment (Bauman & Lenox, 2000) to collect data on students who are seeking their services.
Administrators in the office saw the benefits of an improved data collection procedure as a means for assessment of students and office structure. Improvements to the office can only be justified by conclusions drawn from proper data collection and research (Corazzini, 1997). Counseling efficacy and program evaluation became realistic assessment goals for administrators at the prospect of this new system. Considering the inherent benefits of this endeavor and the pressure to assess, SCO administrators encouraged the project to begin.

Psychology Department

 Concurrently, faculty in the Psychology Department established a psychology scholars program for undergraduate students. The faculty members invited several undergraduate students to conduct and lead team research projects. Selection for the psychology scholars program was based on previous academic achievements, standardized test scores, grade point average, and the student’s interest and potential success in graduate school work. Research projects were to be student-led under a faculty advisor.

 Several students in this scholars program were interested in the research topics that the SCO desired to address. Three teams were assembled, each with different goals: one team to create an instrument to assess same-sex attraction, one team to create an assessment to measure internet pornography use, and one team to collect other measures for use in the intake procedure. This thesis contains the work of the third team. The products of the other two teams were intended for use in the intake procedure and are also included in this thesis. Due to the inherent interest of the psychology students in the
scholars program on these three teams and faculty available to assist in this research, work began immediately.

**Stage One**

**Review of the Literature**

Other college counseling centers have implemented intake procedures to ease the process, provide baseline data, and assess psychological distress that may not be verbally expressed (Smith, Rosenstein, & Granaas, 2001). In addition to this, Kokotovic and Tracey (1987) found that the greatest factor in preventing attrition during the counseling process is his or her satisfaction with the intake process. A student’s first interaction with the counseling process is often the intake procedure. Formulating an effective intake procedure that assesses the needs of students and meets the needs of the counseling staff and administration but does not interfere with the student’s satisfaction was deemed an essential goal.

**Formulation of the Intake Procedure**

**Standard forms.** Scientifically sound psychometric tests were selected for both intake and termination for a variety of reasons. Proper diagnosis, adequate treatment plan, accurate data collection and record keeping, and program analysis would all be enhanced by a published scientifically sound test. Selecting measures for the student population at the university that are valid and reliable, as well as brief and inexpensive, was a primary concern. Measures that are designed for both pre and post-assessment was another priority in selecting tests.

It became apparent that the intake procedure was to be comprised of a standard form and general assessments of psychological health for every student admitted. Further
measures were to be administered for students who met certain criteria. The intake procedure was intended to provide a basic view of the student’s mental health and occasionally include measures that would provide a more detailed assessment for students who warranted further attention.

Sometimes, students can present multiple problems when seeking counseling (Heppner et al., 1994). In addition to the general measure and spiritual awareness test, a consent form (see Appendix A) and other standard forms (see Appendix B) were also required of all students. These forms contained demographic questions and resident information, as well as questions designed to indicate whether a student should complete more tests.

These additional tests were to be completed only by students of whom more information was required. Through a branching procedure, generic questions were written that would notify a staff member that further tests needed to be administered. Twenty-four questions assessing a student’s (a) recent experience and (b) entire life history were included following basic demographic information (see Appendix C).

These questions were designed to bring attention to a potential issue that could be further explored with more tests. Since brevity was a goal for this intake procedure, more tests would only be required for those students who were presenting with those particular issues. Further tests and clinical interviews would cover areas such as same-sex attraction, internet pornography consumption, eating disorders, self-injurious thoughts and behaviors, and drug and alcohol abuse. Issue-driven assessment would thus provide the counselors at the SCO with a more comprehensive psychological assessment of students expressing concern with any of these areas.
**Brief Symptom Inventory.** Considering the need for a general assessment of mental health, the Brief Symptom Inventory (BSI; Derogatis & Melisaratos, 1983) was deemed sufficient for the intake procedure. The BSI is a 53-item general psychological assessment that is reliable with a college student population (Hayes, 1997) as well as those with intellectual disabilities (Kellet, Beail, Newman, & Frankish, 2003).

The BSI measures an individual’s mental health in nine different dimensions: depression, obsessive-compulsivity, interpersonal sensitivity, somatization, anxiety, hostility, phobic anxiety, paranoid ideation, and psychoticism (Cochran & Hale, 1985). Boulet and Boss (1991) found the Cronbach’s alpha coefficients for each dimension ranged from .75 to .89 using a sample of 501 inpatients.

The BSI is a paper and pencil medium which is administered in as little as 10 minutes (Cochran & Hale, 1985) and easy to score by staff members who are not trained in psychological measurements (Hayes, 1997). BSI materials were purchased and the test was easily incorporated into future office budgets.

The BSI may be administered at intake as well as after therapy has been completed. Piersma, Reaume, and Boes (1994) found statistically significant decreases in both males’ and females’ mean scores after therapy on every symptom scale within the BSI. These results build reliability in the BSI to measure what is proposed both at intake and at termination. The BSI does not assess every area that may be seen in a student population. However, the standard forms mentioned previously provide a branching method that would hint at further tests for problems that may be present.

**Spiritual Awareness Inventory.** Another required assessment of the intake procedure was a measure addressing a student’s spiritual state. A faith-based institution
such as the university in which the SCO is located is concerned with the spiritual state of its students. It was anticipated that information received from a student’s scores on a spiritual awareness test would be utilized by the counselors in therapy. The information was also useful in the developments of new outreach ministries and improvements of religious services sponsored by the office.

The Spiritual Awareness Inventory (SAI; Hall & Edwards, 1996; Hall & Edwards, 2002) was selected to measure the spiritual state of the students seeking counseling at the SCO. The SAI was obtained by the authors for use in the SCO (T. Hall, personal communication, February 19, 2009). The SAI is a 47-item test that asks respondents to rate their agreement with each statement regarding their personal spiritual experience on a 5-point scale from not at all true to very true. Five factors with good reliability coefficients emerged from Hall & Edwards’ (2002) analysis after multiple studies. The factors included Awareness ($\alpha=.95$), Disappointment ($\alpha=.90$), Realistic Acceptance ($\alpha=.83$), Grandiosity ($\alpha=.73$), and Instability ($\alpha=0.84$).

The subscales of the SAI have theoretical foundations in object relations theory. Slater, Hall, and Edwards (2001) posit that one’s relationship with others is connected to one’s relationship with God and that spiritual maturity has as many dimensions as human relationships. These dimensions are theorized to be represented in the Instability, Grandiosity, and Realistic Acceptance subscales.

Hall and Edwards (2002) found strong correlations on the Grandiosity scale with the Narcissistic Personality Inventory. This finding gives concurrent validity to the Grandiosity scale. In addition to this finding, the researchers also found the SAI
awareness dimensions to correlate in certain aspects to a Spiritual Well-Being Scale, displaying the convergent validity of the SAI.

**Sexual Identity Survey.** Due to the desire for the SCO to understand the prevalence of students seeking help related to same-sex attraction, it was suggested that a psychology scholars team identify a sexual identity measure. After a review of the literature, it was apparent that a sexual identity survey suitable to the university environment was lacking and needed to be developed particularly for a religious student population. Student data at the university in which it would be implemented became an appropriate sample.

The research team found two predominant theories for homosexuality development in the literature: stage theory and milestone events theory (Buker, 2009). Stage theory posits that an individual progresses through distinct stages in the development of his or her sexual orientation. Milestone events theory instead emphasizes the behavioral aspect of sexual development as a true measure of sexual orientation. The researchers who developed the measure for the SCO adapted the stage model theory.

The Sexual Identity Survey (SIS; Buker, 2009) was developed using a convenience sample (n=582) of which 54 individuals were selected for further analysis. Out of this analysis, the 19-item SIS was finalized with two distinct subscales that are relatively reliable: Confusion (α=.833, N=46) and Decision (α=.829, N=41). The entire scale has a Cronbach’s alpha coefficient of .849 (N=40).

Respondents indicate their agreement with each item as it pertains to their personal sexual identity with **true** or **false**. Total scores are summed for each subscale based on the number of **true** responses. An individual with a score of two or greater in
either subscale indicates that the student may be in that stage. If the scores are both greater than two, the subscale with a greater score would be the identified stage. For example, a greater sum in the Confusion subscale rather than the Decision subscale would indicate that the individual is confused about their sexual orientation rather than decide.

Since this measure was developed for the purpose of the present intake procedure, it is highly appropriate for use (Buker, 2009). In addition, the brevity and reliability of the measure is in accordance with the goals of concise procedure for the SCO. The ability to administer the test after therapy is also useful to collect post-treatment data.

**Cyber-Pornography Use Inventory.** While gleaning the literature for a pornography use inventory, it was found that the literature lacked an appropriate measure for this university culture, a problem similar to finding an appropriate sexual identity assessment. Therefore, a pornography use inventory was also developed in-house for the purpose of assessment within the SCO. The Cyber-Pornography Use Inventory (CPUI; Grubbs, Sessoms, Wheeler, & Volk, 2010) is a 31-item scale developed using a sample of individuals from the same institution as the SIS who responded to a survey about internet pornography use. The sample consisted of 145 individuals who had indicated that they had intentionally viewed pornography within the past six months. Factor analysis revealed three prominent factors with strong reliability coefficients labeled Addictive Patterns ($r=.89$), Guilt Regarding Online Pornography Use ($r=.83$), and Online Sexual Behavior-Social ($r=.84$).

The test asked respondents to rate their behavior and perceptions concerning internet pornography consumption on various scales. Totals for each subscale indicated
the level of reported addiction, guilt, and online social sexual behavior. The test is also appropriate for use after therapy to compare scores on each subscale. Similar to the SIS, the CPUI was considered highly appropriate for use in the SCO due to the development of the measure with the same student population.

**Eating Attitudes Test.** Eating disorders were a concern of the SCO that needed a proper assessment tool to better understand students who have this issue. The Eating Attitudes Test (EAT-26; Garner, Olmsted, Bohr, & Garfinkel, 1982) was selected for inclusion in the intake procedure as it is the most widely used eating disorder test in clinical practice (Mintz & O’Halloran, 2000). The EAT-26 has been adapted from the original EAT-40 version and they have a strong correlation with each other ($r=0.98$; Garner, Olmsted, Bohr, & Garfinkel, 1982). Respondents are asked to rate their behavior and cognitions regarding their personal eating attitudes. Raw scores on the EAT-26 can range from 0 to 37 with higher scores indicating a greater likelihood of having an eating disorder.

The EAT-26 has been found to indicate the presence of an eating disorder in an individual with up to ninety percent accuracy (Mintz & O’Halloran, 2000). This research builds concurrent validity for the EAT-26 as a great majority of the individuals identified by the EAT-26 had an eating disorder diagnosed by the DSM-IV criteria. Additionally, the EAT-26 has been shown to identify disordered eating behavior in non-clinical samples of individuals who may not satisfy DSM-IV diagnostic criteria (Garner, Olmsted, Bohr, & Garfinkel, 1982).

It is not uncommon for college students to score high on the EAT-26. Prouty, Protinsky, and Canady (2002) found that, of their sample ($N=578$), 17% scored higher
than 20. Individuals in that 17% were more likely to be female, white, and Christian. The EAT-26 is a brief measure and can also serve as a pre-post therapy tool to assess the effectiveness of the counseling sessions.

**Ottawa Self-Injury Inventory.** The SCO staff also wanted more information about students who are contemplating or committing self-injurious behavior. This desire for information is supported by the prevalence of self-injurious behavior among college students and the lack of therapy for those individuals (Gollust, Eisenberg, & Golberstein, 2008). The Ottawa Self-Injury Inventory (OSI; Nixon & Cloutier, 2005) is a clinical interview that asks respondents a series of behavior ratings regarding their self-injurious behavior. Highly detailed questions ask students to indicate the many dimensions of their self-injurious behavior.

The form was obtained from the authors for use at the SCO (M. K. Nixon, personal communication, January 27, 2009). While the OSI is not a quantitative measure, an individual’s post-therapy responses to the individual items can be compared to previous responses. The interview can be completed in around ten minutes. Student data can be read by counselors prior to therapy to allow for a more efficient first appointment if self-injurious behavior is a primary issue.

**BRIEfer Drinker Profile.** College students who are excessive drinkers have been found to engage in other risky health behaviors (Kim, Larimer, Walker, & Marlatt, 2007). Because of the concern of the SCO to assess students who may be problem drinkers, the BRIEfer Drinker Profile (BDP; Logan & Parks, 2006) was recommended for use in the intake procedure (D. Pitts, personal communication, January 24, 2009).
The BDP was based on the Brief Drinker Profile (Miller & Marlatt, 1987) and is located in the public domain. As a clinical interview, respondents are asked a series of questions regarding their own drinking behavior as well as other family members’ behavior. Some questions address other drug usage including tobacco, opiates, and inhalants. The entire interview is self-administered in less than ten minutes. The information gathered from this interview is useful for counselors in the SCO as well as during the possible referral process to other facilities. Collecting information after therapy at the SCO, particularly for the behavioral questions, is useful for therapy efficacy analysis.

Stage Two

After the intake procedure was established, it was implemented on a pilot basis at the SCO during the spring of 2009. Scoring sheets and detailed instructions were included with copies of every test in files for each student. Some on-site training was necessary for the staff to understand the recommended process and how each student’s data should be processed. The implementation of the new procedure was accepted immediately.

Detailed instructions were also written to assist staff members who were new to the intake process. Scoring guides were included for each test explaining the statistical jargon and stating normal score ranges. These guides were detailed for the SIS and the CPUI as these tests were recently developed (see Appendix D).

Student files were stored securely in a filing system within the office. It was ensured that protocol included the confidentiality of students’ names and scores. The
filing system was sufficient for the current time. However, filing space was limited and the process lacked efficiency and simplicity in many aspects.

While the pilot test was successfully integrated with some adjustments, it became apparent that the usability of the entire system needed to be improved. The task of assessment was perceived as daunting, particularly in score calculation and reporting. Considering the number of students entering the counseling process, the need for evaluating the current process can be understood. This realization, coupled with the need for secure student records and efficient access, led the research team to consider other alternatives. Creating an electronic version of the intake procedure became the next logical phase of the project.

**Stage Three**

**Computer Administered System**

**Review of literature.** Ease of administration, scoring, data collection, and data analysis would all be greatly improved with an electronic version of the intake procedure. While reviewing the literature for appropriate psychometric assessments, other computer administered intake procedures were discovered, including the Computerized Assessment System for Psychotherapy Evaluation and Research (CASPER; McCullough, Farrell, and Longabaugh, 1986).

Researchers who built the CASPER system collected tests similarly to the current intake process and wrote software tailored to counseling center intake procedures (Farrell & McCollough, 1987). The success of the CASPER encouraged the potential for building a system for the Student Care Office. After considering the potential benefits of a computer administered version of the current intake procedure, the Student Affairs
Office, which oversees the SCO, decided to fund the work necessary to build such a system.

**Development.** During the summer of 2009, the current intake procedure was compiled into a computer version using Microsoft® Office InfoPath® 2007. This program allowed for each field to connect to an individual data source. Information entered in one field could be arranged in complex expressions and render score calculations to be computed automatically. In addition to this, the branching items (see Appendix C) could be programmed to display the appropriate tests depending upon a student’s responses. Since the items were written so that an answer of *yes* indicates that the student should take the appropriate test, a *yes* response to an item will present another test. Certain data sources could also be required to continue the intake procedure, such as a consent statement.

After the tests were assembled and programming was tested, the forms were published to a secure, encrypted database using Microsoft® SharePoint®. This database, owned by the university, was free for SCO use. To access the online SharePoint site, one would have to enter his or her university username and password. Only individuals with a university account have access to the SharePoint site. Since everyone must sign in to this database, permission levels could be set specifically based on individual accounts. This feature allowed the ability to control which SCO staff members can access students’ records. Any other user would not be allowed access. Additionally, non-university personnel would not have access to the site.

While the other forms were obtained with permission, the BSI could not be incorporated in the computer administered version of the intake process due to copyright.
During the intake process, a student completes the paper form of the BSI and a trained staff member scores and inputs the scores into a separate, secure database with the student’s username. The username allows an individual analyzing the data to link the intake database with the BSI database.

After the forms were successfully published to the online database and tested, assembly of the computer systems, from which the procedure would be completed began. The SCO offered use of two dedicated computers, one for each counseling suite, which would be used exclusively for intake. Both machines were placed in a quiet, solitary place in the office where a student can focus on the intake forms. The setup of each machine is similar to those in the computer lab on campus to which every student has access.

Each computer was wiped and an appropriate operating system was installed. Using HTML code, a login page was built for each machine that prompted the user to enter his or her university username and password. This system allowed for the form to collect the current user’s information from the network based upon the username entered and transpose that information to a hidden field within the form. Since a student is required to enter his or her password, this ensured that the person using the machine was not completing the intake form as another individual. When a new form was opened, the system time and date was collected by the form and stored for each record.

Features. As a student completed the required standard forms and the SAI, the branching questions would trigger further tests, if applicable. Each form was located on a single page with areas for responses and a continue button at the bottom of the page. When the required fields were completed, the button activated and allowed the student to
continue to the next form. At the press of the continue button, the student’s record was overwritten with the new information from that page. Therefore, if a student completed the SAI but not the EAT-26, the student’s data was collected up to the SAI. The updated record also stored the time of the last press of a continue button, providing a time at the start of the process and the last known interaction with the form.

The time a student required to complete an intake procedure was relative. While some individuals hurried through assessments, others took time to complete the same questions. During initial testing of the system, it was found that the required portions of the procedure (excluding the BSI) lasted around ten minutes. This timing considered an average reading speed, thought processing and response time, as well as the time required to load each page of the form. Additional tests added more time, particularly the clinical interviews due to the length of those measures. If an individual completed every test in the intake procedure, the total time may exceed a half-hour. Since it was considered unlikely that a student may present with the need to complete every assessment, it was assumed that thirty to forty-five minutes would usually be sufficient for an individual to complete the computer administered intake procedure.

A procedure for utilizing the tests for follow-up evaluations was also established. When a student was directed to complete the forms after therapy, the sign-in process was identical. When a student signed in, the form checked the database for an instance of the username and, if one was found, collected which tests were triggered at intake and presented only the appropriate tests. For example, if a student completed only the EAT-26 and the required SAI, at a second login the SAI and EAT-26 would be displayed as requiring a second completion. Standard forms were seen to be redundant as
demographic information was unlikely to change over the course of therapy, particularly therapy occurring within one semester. This procedure did not allow any extraneous information and made the process as swift as possible.

An additional feature within the form was a display of the student’s record. This view was hidden from students and was intended for counselors only. Counselor usernames were programmed to trigger the counselor view. In a similar process to a second attempt of completing the form, the form itself compared the username of the current patron to a list of counselor usernames managed by a staff member in the office. If the current username was listed as a counselor, the student’s record was displayed. A summary page of tests completed, as well as every response the student had made, was displayed for the counselor. Using buttons the counselor could navigate the student’s record to find the information required with relative ease. Records could not be edited from this view, so data remained secure.

**Benefits.** Time stamping the forms allowed for analysis of the beginning time and end time of a student’s intake process. It must be noted that this time did not consider the BSI, and therefore was not a true representation of a student’s entire time completing an intake process. Time stamping also allowed staff to understand when most individuals were able to schedule intake appointments. Other benefits of this system included a more accurate data input as human error can occasionally interfere with data entry of long forms and is often a tedious task. Data analysis was also greatly improved due to the ability of SharePoint® to download student records in a spreadsheet format that was easily imported into statistical analysis software.
Staff hours were saved due to the administration, scoring, and data entry of the tests. Instructions were given to the student regarding the navigation of the form and all other instructions were presented electronically. The computers for completing the form were located in a relatively quiet and confidential area of the office. This allowed the student to focus on the questions on the screen rather than hiding answers from others when completing the form on a clipboard. Confidentiality was also enhanced due to a reduced interaction between office workers and an individual’s scores.

The speed with which a student would complete the intake process also improved. Electronic responses could easily be completed with radio buttons and short responses rather than writing every answer. Requiring certain responses in order to continue on the form also automatically ensured that all responses that the SCO desired for assessment purposes were included.

**Check-in Kiosks**

**Development.** During the fall of 2009, as a result of the improved intake system, the SCO decided to change the check-in sheet located on the front desk of the office. The paper check-in sheet presented obstacles to confidentiality as students who would sign the sheet would be able to read the previous names. To protect the information of students who visit the SCO, it was decided that an electronic form, similar to the intake procedure, should be developed. The SCO administration decided what information was appropriate to collect and the form and database were developed using the same programs that were used to develop the intake procedure.

**Features.** The form included demographics such as name, gender, student identification number, as well as email and cell phone number. The form also asked the
student to indicate the reason for visiting the office. If counseling was selected as a response, an additional information box appears. This required box asked which counselor the student has scheduled an appointment with, if any, and the main presenting issue, before a student could submit the form. This process ensured that the SCO collected the appropriate data for analysis.

Similar to the intake procedure, each form was time stamped at the start of the form. Since the new protocol for office staff was to direct students to check-in as soon as the student entered the office, that data could be analyzed to determine the amount of traffic entering the office at any given time. In addition to the data submitted to the online database, an email containing a summary of the information that the student entered was simultaneously sent to the SCO email account. This information was then transposed to new appointments that were made on a counselor’s calendar.

**Benefits.** Collecting data on the time of day and day of the week has allowed the administration to consider restructuring office hours to meet the availability of students. Office hours, as well as availability of staff, can now be adjusted based on numerical findings. New budget proposals can be considered based on this quantitative data; moreover, new staff hires can be made if one student gender or issue is more frequent than another. This process prevents the student’s presenting issue from being stated aloud and was likely to produce a more detailed report rather than a brief statement.

Furthermore, information from the check-in kiosks can be linked with data from the intake procedure based on the student identification number, which is a required field. This should prove useful in assessing how many students who enter the office complete an intake procedure. Differences between a student’s first interaction with the office and
the intake time, as well as the termination procedure, can display a student’s supposed timeline within the office.

A manual was also written to accompany the check-in kiosks (Appendix E). This manual details the proper downloading, cleaning, and organization of the data for analyses. It also provides a step-by-step guide to basic statistical software and word processor skills that are necessary for running analyses and organizing data to be reported. Considering that office staff may change, the manual is written assuming no previous training in the system and outlines the entire process from start to finish. Screenshots are also included in the manual that should increase the ease of the analysis and reporting process.

**Future Directions**

**Measures**

The Sexual Identity Survey (SIS; Buker, 2009) and the Cyber-Pornography Use Inventory (CPU; Grubbs, Sessoms, Wheeler, & Volk, 2010) have not been tested on a clinical sample. With permission from the IRB of our institution, the Student Care Office data could be used to validate and build reliability to those measures in future studies. The data collected from these measures is highly applicable for further development as the measure is used with the same population. Additional research and development of these tests may be required in light of possible findings.

The BSI has been criticized for lacking appropriate college student norms (Cochran & Hale, 1985). It is suggested that a counseling office creates norms for the student population in which it is located. The SCO should consider this due to the characteristics and purpose of the office. This goal may be accomplished with the data
collected from intake forms from the first year of use, and these norms may be updated with new data collected throughout the years.

**Student Care Office**

Guidelines for accreditation in University and College Counseling Services are outlined by Garni et al. (1982). While some aspects would require large budgets and major alterations of the current system, accreditation is a reasonable goal. The guidelines are designed for the betterment of the services and the student clientele, so striving to meet them would have a positive result. Future studies may expand on the vision of a scientific intake procedure for a faith-based student counseling service that strives to meet the needs of its students. Improvements in advertising, architecture, and staffing are a few suggestions for further study.

For an approach to counseling process, other large universities approach the counseling service structure in different ways. Some centers use a hierarchical system, in which a counselor oversees the sessions of an intern, while some institutions utilize a team-based system, in which counselors and interns collaborate to assess and initiate counseling (Murphy & Martin, 2004). Considering the staff and availability of undergraduate interns and graduate students at the university, a team-based assessment may be favorable. According to the model presented by Murphy & Martin (2004), senior staff, counselors, interns, and graduate students would form groups of four or five to assess test scores and interviews and suggest a treatment plan. This allows for student clientele to be assessed in a sensible and less stressful manner while the graduate students and interns in the group can learn by participating as well as acquire hours in pursuit of their degree.
References


### Appendix A

**Consent Form**

**Informed consent for assessment, treatment, and research**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td></td>
</tr>
<tr>
<td>Middle name</td>
<td></td>
</tr>
<tr>
<td>Last name</td>
<td></td>
</tr>
<tr>
<td>Student ID:</td>
<td></td>
</tr>
<tr>
<td>Date of birth:</td>
<td></td>
</tr>
<tr>
<td>Meeting with:</td>
<td></td>
</tr>
</tbody>
</table>

I understand that as a residential student at Liberty University, I am eligible to receive a range of services at Student Care. The type and extent of services that I will receive will be determined following an initial assessment and thorough discussion with me. The goal of the assessment and treatment process is to determine the best course of treatment for me. Typically, treatment is provided over the course of several weeks.

I understand that all information shared with the counselors at Student Care is confidential and no information will be released without my consent. During the course of treatment at Student Care, it may be necessary for my counselor to communicate with providers of other health care services. Written authorization is not required, prior to any discussion with other health professionals, understanding that my counselor will discuss all communications with me prior to those communications. In all other circumstances, consent to release information is given through written authorization. Verbal consent for limited release of information may be necessary in special circumstances. I further understand that there are specific and limited exceptions to this confidentiality which include the following:

- When there is risk of imminent danger to myself or to another person, the clinician is ethically bound to take necessary steps to prevent such danger.
- When there is suspicion that a child or elder is being sexually or physically abused or is at risk of such abuse, the clinician is legally required to take steps to protect the child, and to inform the proper authorities.
- When a valid court order is issued for your records, the clinician and the agency are bound by law to comply with such requests.

I understand that the Student Care counselors and staff may not be licensed or certified by any government or other licensing organization.

I understand that all Student Care counselors will be practicing Christians, active in their faith and involved in their local church.

The purpose of counseling is: (1) to identify the issues that are causing you distress; (2) to help you resolve those issues; and (3) to achieve positive results through a process of personal change.

Unfortunately, there are no guarantees that any counseling process will be effective. Change is not always easy, and can sometimes be slow and even frustrating. Further, the counseling process sometimes involves working through personal issues that can result in emotional or psychological pain for the client. Attempting to resolve the issues that brought you to counseling in the first place may create additional underlying issues, or result in changes that were not originally intended.

Counseling often involves difficult decisions about changing behaviors, employment, substance use, schooling, housing, relationships, or virtually any other aspect of your life. Sometimes a decision that is positive for one person or family member is viewed quite negatively by another person or family member. Further, in the case of marriage and family counseling, interpersonal conflict can increase as family issues are discussed.

I understand that there will be times when my records may be accessed by assessment personnel and academic researchers for the purposes of improving services at Student Care.

If I have any questions regarding this consent form or about the services offered at Student Care, I may discuss them with my counselor. I have read and understand the above. I consent to participate in the evaluation and treatment offered to me by Student Care. I understand that I may stop treatment at any time.

- [ ] I agree to the above consent form.
- [ ] Date:

Continue

The "Continue" button will only work when all *required* questions are answered.
Appendix B

Intake Form

Student Basic Information
*First name:  
*Middle name:  
*Last name:  
*Date of birth:  
*Phone number: (ex. (123) 456-7890)  
*Student ID#:  
*Sex:  
Male  Female  
*Race:  
White  Black  Hispanic  Asian  Other  
*Residence:  
Main campus  East campus  Off campus  Lynchburg Inn  
*Class status:  
Freshman  Sophomore  Junior  Senior  
*Academic major:  
*Are you an international student?  
Yes  No  
Insurance company:  
Mental health benefits:  
Yes  No  Unsure  
*Emergency contact information:  
Name:  Relation to student:  Phone number: (ex. (123) 456-7890)  
Select...  
Name:  Relation to student:  Phone number: (ex. (123) 456-7890)  
Select...  

Student Visit Information
Why are you here today?  
How long has this issue been going on (days, months, years)?  
How are you physically feeling today?  
In the past month, how have you been sleeping?  Normal  More than usual  Less than usual  
Within the past month to the present, have you taken any medication(s) (i.e. prescription or over-the-counter)?  
Yes  No  

Student Mental Health
*Have you ever met with a licensed professional counselor before?  
Yes  No  
*Has any professional ever diagnosed you with or said that you have a mental illness or emotional problem?  
Yes  No  
*Are you currently receiving psychiatric/mental health treatment? (check all that apply)  
None  Residential  Outpatient clinic  
Medication  Counseling  Other:  
*Have you ever been hospitalized for any mental health problems?  
Yes  No
### Appendix C

#### Student Experience History

Please carefully consider the following questions. If the following question applies to you, please indicate by selecting “Yes”. If the following question does not apply to you, please indicate by selecting “No”. Answer the questions considering your entire life history.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Have you ever considered forcing yourself to throw up after a meal?</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Have you ever intentionally viewed pornography?</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Have you ever consumed alcohol to excess or used an illegal substance?</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Have you ever felt you could not control your eating?</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Have you ever purposefully inflicted harm on yourself?</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Have you ever been confused about your sexual orientation?</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Have you ever had sexual thoughts about or been attracted to a member of the same-sex?</td>
<td>Yes</td>
</tr>
<tr>
<td>8</td>
<td>Have you ever identified as being gay, lesbian, bisexual or homosexual?</td>
<td>Yes</td>
</tr>
<tr>
<td>9</td>
<td>Have your parents ever consumed alcohol to excess (been considered alcoholic) or used an illegal substance?</td>
<td>Yes</td>
</tr>
<tr>
<td>10</td>
<td>Have you ever attempted suicide?</td>
<td>Yes</td>
</tr>
<tr>
<td>11</td>
<td>Have you ever significantly restricted your consumption of food?</td>
<td>Yes</td>
</tr>
<tr>
<td>12</td>
<td>Have you ever considered ending your life?</td>
<td>Yes</td>
</tr>
</tbody>
</table>

#### Student Current Experiences

Please carefully consider the following questions. If the following question applies to you, please indicate by selecting “Yes”. If the following question does not apply to you, please indicate by selecting “No”. Answer the questions considering your experiences in the past month.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Within the past month, have you considered forcing yourself to throw up after a meal?</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Within the past month, have you intentionally viewed pornography?</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Within the past month, have you consumed alcohol to excess or used an illegal substance?</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Within the past month, have you felt you could not control your eating?</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Within the past month, have you purposefully inflicted harm on yourself?</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Within the past month, have you been confused about your sexual orientation?</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Within the past month, have you had sexual thoughts about or been attracted to a member of the same-sex?</td>
<td>Yes</td>
</tr>
<tr>
<td>8</td>
<td>Within the past month, have you identified as being gay, lesbian, bisexual or homosexual?</td>
<td>Yes</td>
</tr>
<tr>
<td>9</td>
<td>Within the past month, have your parents consumed alcohol to excess (been considered alcoholic) or used an illegal substance?</td>
<td>Yes</td>
</tr>
<tr>
<td>10</td>
<td>Within the past month, have you attempted suicide?</td>
<td>Yes</td>
</tr>
<tr>
<td>11</td>
<td>Within the past month, have you significantly restricted your consumption of food?</td>
<td>Yes</td>
</tr>
<tr>
<td>12</td>
<td>Within the past month, have you considered ending your life?</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Continue button will only work when all questions are answered.
The Student Care Intake Procedure is part website and part InfoPath/SharePoint. The entire system has been designed to make the intake procedure self-directed and intuitive, although some students may need additional assistance.

1. When the machine is booted, there is an icon on the desktop of both Intake computers that is labeled “Start.bat”. This is a script that will automatically start Internet Explorer in kiosk mode and go directly to the first webpage (Figure 1).

2. When a student comes in for an intake appointment, the student should be directed to the intake computer and told to click on the Login button. This will bring up a security window asking for a username and password (Figure 2). The student may not know what this is and should be instructed to type in the same username and password that they use to log in to their email, an ILRC computer lab computer, etc.

*Troubleshooting: If the username and password are correct, but do not seem to be working, instruct the student to log in using their full email address as the username (e.g. username@liberty.edu) and their password. Also check for CAPS lock. If the username or password is incorrect, or if the Cancel button is clicked, the form will not display and instead an “Access denied” error will come up. In the event of this happening, you can go back by right clicking on the page and selecting “Back” on the menu or by pressing F5 on the keyboard to Refresh the page.
3. After they successfully log in, the intake form will begin (Figure 3). Instructions are included in the form from here, but a few areas may be confusing. The order of the pages are as follows:
   i. Menu (Begin)
   ii. Consent Form
   iii. Intake Form (Basic Info.)
   iv. Spiritual Awareness Inventory
   v. Menu (Links to Additional Tests)
   vi. Menu (Finish)

4. After the Finish button is pressed (which will only activate when all forms are complete) a page will display that tells the student that the form has been successfully submitted. After 5-10 seconds, this page will automatically redirect to the Login page for a new student to begin.

Form Opening Rules

1. When a new form is opened, the form pulls the current username which the student used to log in to the machine. This username is assigned by Liberty and is unique for each individual; therefore, it will be used to pull an individual student’s scores and answers for counselor use.

2. The next rule the form performs is to check SharePoint for any occurrence of the current user’s username. If the username finds a match in the SharePoint library, it will pull the previous tests that the student completed, since this is their second time completing the form. This allows them to bypass having to take the entire test again and only asks for the pertinent information. Any additional attempts to fill out a new form by this username will continue to pull the previous tests, so subsequent form submissions are infinite.

3. If the current username is equal to a list of counselors located in SharePoint, the form will switch to a view for counselors. Since the form will open this way when a counselor clicks on an individual student’s form, the form will fill with that individual student’s data. This counselor view contains every form a student could fill out, but is only populated with what the student actually completed. A summary of scores is also included for easy reference.

Completing the Form

1. InfoPath forms at the core are comprised of fields and data sources. A field can be a text box, a radial button, a checkbox and other various areas for input. A data source is the place where the data from that field is stored. Both fields and data sources can exist without being connected to each other and multiple data sources can be connected to one field and vice-versa. Therefore, as is with the case in this form, some data sources can be within the form yet completely hidden. These data sources can be used to calculate scores and/or help the form operate “behind the scenes”. When a student submits the form, the data in the data sources is transferred to a SharePoint library where each data source has a corresponding column in which it is stored.

2. The form itself will be completed at one of the two stations in Student Care. The InfoPath client and the actual form will be located on both machines. Data will be submitted via the network to a designated SharePoint library.
   a. When a student accesses the form for the first time, they will begin on the Menu page (or view) and will be prompted to begin.
   b. The first form they see will ask for basic information and their consent.
form pulls a date and time from when it was opened and this remains the same until it is submitted for the last time.

c. The next form is the standard intake form. More demographic information, as well as contact and medical information, is gathered at this time. The last sections of the standard intake form ask branching questions. These questions will trigger which forms the student will complete next.

d. The Spiritual Assessment Inventory is next. The student completes this form and will click to continue.

e. The student is then directed back to the Menu screen where new buttons now exist. These buttons appear based on the student’s previous answers in the intake form. For instance, if a student answered “yes” to a question about their negative eating behaviors, the form will present a button to complete the Eating Attitudes Test. (The 12 questions located in the intake form are stored in “control” data sources as well as “total” data sources. The “total” data sources are submitted to SharePoint untouched so when a this student accesses the form again, they are pulled into the “control” data sources triggering the same forms completed previously to appear again. The “control” data sources, however, change as the student completes the respective forms. This will be explained in the Scoring section.)

f. The student is instructed to complete the forms that appear (if any) and click the Finish button (which closes the form) when they are finished. The Finish button does not activate unless all of the necessary forms have been completed.

g. The following are some graded tests that the student may be prompted to complete: the Sexual Identity Survey, the Cyber-Pornography Use Inventory, and the Eating Attitudes Test. The BRIEFer Drinker Profile, and the Ottawa Self-Injury Inventory are two clinical interviews that the student may also be prompted to complete.

Scoring

As each test is completed, a continue button located at the end of every form performs a few actions. The buttons in the graded tests compute the averages or totals for the respective form and places those values in the appropriate data sources. The clinical interviews don’t have scores to compute, so this rule is not included. The next rule fills the respective control data source with a value that makes the button disappear.

For instance, the EAT appears for a student that answered “yes” to at least one question in the standard intake form. This data is stored in the “total” data source for future reference and in the “control” data source for the current form. The EAT button appears because the “control” data source for the EAT is greater than 0 (where it began). When the student clicks on continue button at the end of the EAT when finished, the “control” data source is filled with a 0 again, therefore making the button disappear and bringing them one step closer to clicking the finish button.

Submission

The final rule that each button performs is a submission of the new data. Submission of data occurs in the standard intake form, the SAI, and any subsequent tests that the student needs to complete. Since there are multiple submissions, the students form is overwritten every time a submission is made. This provides two benefits: Students who refuse to continue the form have at least some data in their record, more than what would be there if the form was submitted only once at the end of everything. Additionally, the form is only overwriting the
current record as it holds the date and time all the way through. Therefore, subsequent forms do not affect previous data.

Important Terms

- **username** – the student or counselor’s username as assigned by Liberty
- **SharePoint** – the site owned by Liberty used by separate departments
- **SharePoint library** – a “folder” of sorts where documents or forms are stored
- **list** – a list of data that can be pulled for use in an InfoPath form
- **view** – another page of the same form
- **InfoPath** – the program used to create the actual form
- **field** – a textbox, radio button, or checkbox where data is input by the user
- **data source** – a hidden area where data from the field is stored, or other data sources are computed
- **submits** – submission sends all of the data from the form to the correct library for one student
- **column** – how data in the library is stored, similar to columns in Excel, with one column representing each data source
- **branching** – referring to the effect of one form having numerous possible paths of completion

Form Descriptions

<table>
<thead>
<tr>
<th>Form Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consent Form</td>
<td>Provides a statement of consent for research and confidentially and a place to accept. Also collects some basic information and sets the date of completion.</td>
</tr>
<tr>
<td>Standard Intake Form</td>
<td>Basic and demographic information plus the student’s current experiences and life history questions which are used to determine if additional tests are needed.</td>
</tr>
<tr>
<td>Spiritual Awareness Inventory</td>
<td>Measures a person’s spiritual awareness as it pertains to their overall awareness, realistic acceptance, disappointment, grandiosity, impression management, and instability.</td>
</tr>
<tr>
<td>Sexual Identity Survey</td>
<td>Provides the counselor with information on whether the student is confused or decided about their sexual orientation.</td>
</tr>
<tr>
<td>Cyber-Pornography Use Inventory</td>
<td>Provides information on a student’s internet pornography use, their guilt, and their possible addiction.</td>
</tr>
<tr>
<td>Eating Attitudes Test</td>
<td>Used to measure an individual’s attitudes and behaviors concerning food and eating.</td>
</tr>
<tr>
<td>BRIEFer Drinker Profile</td>
<td>Asks information pertaining to alcohol and drug abuse and related life occurrences.</td>
</tr>
<tr>
<td>Ottawa Self-Injury Inventory</td>
<td>Asks the student about self-injurious behavior and, separately, suicidal behavior as well as pertinent life events.</td>
</tr>
</tbody>
</table>
1. To access Student Care Kiosk data, open Internet Explorer and navigate to the following address.

2. Navigate to the right side of the screen and click on the View drop-down box. Click on the “Report” view. This view displays the appropriate data values that are currently used for reports.

3. Click on “Modify this View”.

4. Scroll down to the “Filter” section and notice the “Show items only when the following is true:” selection. This feature will filter the records to whatever conditions set by the user. In order to filter by date, the “Created” column (a column containing the exact time that a form was submitted) must be given two cut-off points. The first day of the week is to be entered in the “Created is greater than or equal to” and the last day of the week is to be entered in the “Created is less than or equal to”. (For example: Monday, February 15, 2010 is entered as 2/15/2010 and Friday, February 19, 2010 is entered as 2/19/2010). This will allow only the previous week’s records to display.

Click OK.
5. After the view has successfully loaded, navigate to the “Actions” and select “Export to Spreadsheet”. This option will allow the data that is currently in the view to download as an .iqy file which can be opened by Microsoft Excel—and opens this way by default. (In addition to opening as a spreadsheet, the file is also Enabled to connect to the SharePoint Library it was downloaded from. This feature is unnecessary when downloading data from a view that is defined by a certain time.)

Save the .iqy file to the Assessment folder as the last day of the week (e.g. February 19)

6. Open the Assessment folder and navigate to the .iqy file that was just saved. Double-click on it and it should open in Microsoft Excel. Save the Excel (.xlsx) file under the same name as the .iqy file in the Assessment folder.

7. Open the current version of SPSS Statistics.

8. Click File → Open → Data… Navigate to the Assessment folder. Change the “Files of type:” dropdown box to “Excel (*.xls, *.xlsx, *.xlsm)”.
9. Select the file that you saved in Excel and click Open.

   Click OK in the next dialog box.

10. Depending on the characteristics of this dataset, a different syntax file should be opened.

   Click File → Open → Syntax…

   Navigate to the Assessment folder and click on the appropriate syntax file.
11. a) Verify that the “SPSS Statistics Data Editor” displays [DataSet1] after the file name (it is “*Untitled” by default until you save the file).

b) Select all text and click the Run button in the toolbar. (Be sure to select ALL text in the syntax file or the analyses will not run correctly.)

12. After the syntax has run, the analyses will be located in the Output file. The output will consist of various tables and graphs displaying the data in an organized manner. All of the graphs will need to be adjusted to best display the data for the reports. This process is accomplished through various graph Templates. These template files are also located within the Assessment folder and should be named according to its purpose.

For example, the gender graph should be adjusted using the GenderPie.sgt template file. This procedure is detailed in Note 3.
13. To copy elements (charts, tables, etc.) from the Output file to the Word report, select only the element and click Copy.

14. Open Microsoft Word and navigate to the Assessment folder where the Reports are located. Open an old report

Click File → Save As

And save the new file with the appropriate date and title.

15. When copying and pasting charts and graphs from SPSS to Word, tables must be pasted in the following manner.

Right click the table and click Copy.

In Word, select the previous table from last week that you are replacing and click Paste → Paste Special…

Another window will appear, select any of the Picture options and click OK. The table should be pasted as a picture. Adjust size as needed but be aware of the readability of the text.
16. Graphs can be copied and pasted with right clicks.

17. Continue to copy and paste all relevant tables and graphs into the Word document report. Change the title of the report to the Friday of the week that is represented.

18. Click on the Acrobat tab.

Then click the Create PDF button and save the file in the appropriate folder.

The PDF convertor will run. When it is finished, your report has been completed. Double-check the PDF to ensure that each element looks correct and is in a legible condition. Make changes, if necessary to the Word file and then create a new PDF with the same name.
1 If a view is not already established under your account, the following screenshot will show the correct fields that should be displayed. Additional fields may be added and included in future data analysis; however, the fields listed are sufficient as of Spring 2010.

### Student Care Kiosk Fields

<table>
<thead>
<tr>
<th>Display</th>
<th>Column Name</th>
<th>Position from Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>Type (can link to document)</td>
<td>1</td>
</tr>
<tr>
<td>☑️</td>
<td>Created</td>
<td>2</td>
</tr>
<tr>
<td>☑️</td>
<td>First Name</td>
<td>3</td>
</tr>
<tr>
<td>☑️</td>
<td>Last Name</td>
<td>4</td>
</tr>
<tr>
<td>☑️</td>
<td>Gender</td>
<td>5</td>
</tr>
<tr>
<td>☑️</td>
<td>Student Id</td>
<td>6</td>
</tr>
<tr>
<td>☑️</td>
<td>Email</td>
<td>7</td>
</tr>
<tr>
<td>☑️</td>
<td>Student Type</td>
<td>8</td>
</tr>
<tr>
<td>☑️</td>
<td>Live Here</td>
<td>9</td>
</tr>
<tr>
<td>☑️</td>
<td>Campus Room Number</td>
<td>10</td>
</tr>
<tr>
<td>☑️</td>
<td>Cell Phone Number</td>
<td>11</td>
</tr>
<tr>
<td>☑️</td>
<td>Intake Survey</td>
<td>12</td>
</tr>
<tr>
<td>☑️</td>
<td>Care Officer</td>
<td>13</td>
</tr>
<tr>
<td>☑️</td>
<td>Visit Reason</td>
<td>14</td>
</tr>
<tr>
<td>☑️</td>
<td>Local Street 1</td>
<td>15</td>
</tr>
<tr>
<td>☑️</td>
<td>Local Street 2</td>
<td>16</td>
</tr>
<tr>
<td>☑️</td>
<td>Local City</td>
<td>17</td>
</tr>
<tr>
<td>☑️</td>
<td>Local State</td>
<td>18</td>
</tr>
<tr>
<td>☑️</td>
<td>Local Zip</td>
<td>19</td>
</tr>
<tr>
<td>☑️</td>
<td>Person Type</td>
<td>20</td>
</tr>
<tr>
<td>☑️</td>
<td>If Other</td>
<td>21</td>
</tr>
</tbody>
</table>

### Student Conduct Kiosk Fields

<table>
<thead>
<tr>
<th>Display</th>
<th>Column Name</th>
<th>Position from Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>Type (can link to document)</td>
<td>1</td>
</tr>
<tr>
<td>☑️</td>
<td>Name (linked to document with edit menu)</td>
<td>2</td>
</tr>
<tr>
<td>☑️</td>
<td>Modified</td>
<td>3</td>
</tr>
<tr>
<td>☑️</td>
<td>Modified By</td>
<td>4</td>
</tr>
<tr>
<td>☑️</td>
<td>Created</td>
<td>5</td>
</tr>
<tr>
<td>☑️</td>
<td>First Name</td>
<td>6</td>
</tr>
<tr>
<td>☑️</td>
<td>Last Name</td>
<td>7</td>
</tr>
<tr>
<td>☑️</td>
<td>Student Id</td>
<td>8</td>
</tr>
<tr>
<td>☑️</td>
<td>Email</td>
<td>9</td>
</tr>
<tr>
<td>☑️</td>
<td>Cell Phone Numb</td>
<td>10</td>
</tr>
<tr>
<td>☑️</td>
<td>Local Street 1</td>
<td>11</td>
</tr>
<tr>
<td>☑️</td>
<td>Local Street 2</td>
<td>12</td>
</tr>
<tr>
<td>☑️</td>
<td>Local City</td>
<td>13</td>
</tr>
<tr>
<td>☑️</td>
<td>Local State</td>
<td>14</td>
</tr>
<tr>
<td>☑️</td>
<td>Local Zip</td>
<td>15</td>
</tr>
<tr>
<td>☑️</td>
<td>Visit Reason</td>
<td>16</td>
</tr>
<tr>
<td>☑️</td>
<td>IF Other</td>
<td>17</td>
</tr>
<tr>
<td>☑️</td>
<td>Conduct Officer</td>
<td>18</td>
</tr>
<tr>
<td>☑️</td>
<td>Live Here</td>
<td>19</td>
</tr>
<tr>
<td>☑️</td>
<td>Campus Room Number</td>
<td>20</td>
</tr>
<tr>
<td>☑️</td>
<td>Destination</td>
<td>21</td>
</tr>
<tr>
<td>☑️</td>
<td>Person Housing</td>
<td>22</td>
</tr>
<tr>
<td>☑️</td>
<td>Visiting Address</td>
<td>23</td>
</tr>
<tr>
<td>☑️</td>
<td>Phone Numb</td>
<td>24</td>
</tr>
<tr>
<td>☑️</td>
<td>Date Out</td>
<td>25</td>
</tr>
<tr>
<td>☑️</td>
<td>Time 1</td>
<td>26</td>
</tr>
<tr>
<td>☑️</td>
<td>Time Designation</td>
<td>27</td>
</tr>
<tr>
<td>☑️</td>
<td>Date In</td>
<td>28</td>
</tr>
<tr>
<td>☑️</td>
<td>Time 2</td>
<td>29</td>
</tr>
<tr>
<td>☑️</td>
<td>Time Day 2</td>
<td>30</td>
</tr>
<tr>
<td>☑️</td>
<td>Status PN</td>
<td>31</td>
</tr>
<tr>
<td>☑️</td>
<td>Permission Semester</td>
<td>32</td>
</tr>
<tr>
<td>☑️</td>
<td>Permission Reason</td>
<td>33</td>
</tr>
<tr>
<td>☑️</td>
<td>Student Type</td>
<td>34</td>
</tr>
<tr>
<td>☑️</td>
<td>Gender</td>
<td>35</td>
</tr>
<tr>
<td>☑️</td>
<td>Duration</td>
<td>36</td>
</tr>
<tr>
<td>☑️</td>
<td>Additional Info</td>
<td>37</td>
</tr>
<tr>
<td>☑️</td>
<td>Dorm Name</td>
<td>38</td>
</tr>
<tr>
<td>☑️</td>
<td>Other Dorm Name</td>
<td>39</td>
</tr>
<tr>
<td>☑️</td>
<td>RA Email</td>
<td>40</td>
</tr>
<tr>
<td>☑️</td>
<td>App Status</td>
<td>41</td>
</tr>
</tbody>
</table>

2 Syntax files are basically a series of “code” that run analyses and generate graphs for particular variables. The syntax files included in the Assessment folder are appropriate only for the datasets downloaded from the Kiosk libraries. In addition, there are syntax files for weekly reports and for semester-long reports. Different analyses are generated depending on the time period. For this manual, the weekly syntax file is used.
In order to apply the correct format to each graph, template files have been included. To apply these, double-click on the graph that needs to be adjusted.

This action will open the Chart Editor window.

Go to File ➔ Apply Chart Template…
Navigate to the Assessment folder and select the appropriate .sgt file. In this case, it is GenderPie.sgt.

Delete the unnecessary text, such as “Gender” (as you will have this title in the Report) and resize the legend font size by selecting the text and using the menu.
After making changes, close the Chart Editor. The changes will now be permanent and the chart is ready to copy into the report.